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1 TRANSACTION SET ARCHIVER

Overview
The Transaction Set Archiver is a means to collect data from a site using 
an event based system inherent to the Verifone Site Controller. The 
advantage of using the Transaction Set Archiver is that password 
maintenance is not required. 

Event Manager, a part of the Transaction Set Archiver, sets up a secure 
trusted relationship between a Site Controller and a trusted Web Server 
(“server”), by requiring a secure log in and access to establish that 
relationship. 

Once the relationship is established, data is delivered to the server from 
the Site Controller on a timed or event based intervals (events). While 
password management is not required, maintaining the user is. If the user 
is deleted or permissions are reduced it can affect the Transaction Set 
Archiver’s ability to process the events. 

The event based system on the Site Controller generates a temporary 
token (cookie) for the event notifications sent to the server. The server 
then uses the cookie to request data. The cookie is based on the 
permissions of the Mapped User at the time the event was generated. 

The Transaction Set Archiver requires a resident Apache HTTP Server. 
Events can be set up and managed with the Event Manager. 

When a configured event (such as a period close) occurs, the Event 
Generator on the Site Controller sends an event message to the Apache 
HTTP Server on the client PC, which activates the event handlers. 

The event handlers on the client PC then send a request for data sets 
back to the Site Controller, which responds by delivering the data sets to 
the client PC. See the “Event Management System - Overview” diagram.
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Event Manager
The Transaction Set Archiver Setup allows you to install the Event 
Manager, which is a tool used to select and configure specific Site 
Controller events that occur on Site Controllers with base 156 or higher 
software. The events that can be managed are:

– Application Start
– Period Close
– Fuel Initialization
– Funds Audit
– Manager Workstation
– Sales Monitor
– Peripheral Status

Event Manager provides other support functions to manage the registered 
events: restoring events on a fresh installation, replicating events from 
one site to another, and deleting/modifying existing events.

Event Processing Utility

After an event is configured with the Event Manager, you can use the 
Event Processing Utility to configure a set of instructions to process any 
of the incoming events on the Apache server. The instructions can include 
the following actions:

– Save the received data to a file.
– Send a message to an email address.
– Run a script file to process the received data.

For example, if you want to know when the system restarts, you can set 
up an event process that saves the information to a file and sends you a 
notification of the event via email.
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Developing a Data Collection Plan
The following sections provide guidelines for developing a data collection 
plan.

Computer(s) for Data Collection and Storage

You must first decide which computer(s) to use for data collection. 
Consider the following:

– If collected data are to be permanently archived, storage 
capacity is important.

– If custom software is required for data processing, computing 
power may be a factor.

– If data are collected on a computer on which the Management 
Suite is installed, the data can be viewed with the Transaction 
Manager.



2 INSTALLATION

Starting Installation

Installing Apache

1. Download a compiled version of Apache from a trusted source for 
the Windows version of the “server” it will be installed on. 

2. After Apache is installed run a test to ensure it properly runs. 

3. Configure Apache to accept HTTPS requests.  

4. If the system did not need to be “patched” the processSiteEvent 
file will need to be moved from the tsaScripts/cgi-bin directory to 
the Apache cgi-bin location. 

5. Ensure the path to the “processSiteEvent.wsf” is correct. If it is 
not correct, modify it to point to the correct location. 

6. Save file. 

It might be necessary to patch the Windows system first for 
Windows 7 and 8 and Sever 2008 and 2010. Please reference the 
ISD Engineering Bulletin 0235 for more information.
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Installing Transaction Set Archiver

1. Insert the Site Transaction Set Archiver CD. If the CD does not 
automatically launch the installer, do the following: 

2. Click Start > Run.
a. In the Open text box, type: e:\SEMInstall.exe. (Replace “e:” 

with your CD drive letter.)
b. Click OK.

3. The Site Transaction Set Archiver Setup dialog box appears.

The minimum screen resolution for displaying the Event Manager 
and the Event Processing Utility is 1024 x 768 pixels.
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Installing Archiver Components
1. In the Transaction Set Archiver Setup dialog box, select Archiver 

Components.

2. Click Next. The License Agreement appears.

3. Read the license agreement. If you accept the terms of the license 
agreement, click I accept the terms in the license agreement. 
(If you do not accept the terms, click Cancel to quit the 
installation.)

4. Click Next. The Scripts Location dialog box appears.
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 Installing the Event Processing Utility
1. In the Site Transaction Set Archiver Setup dialog box, select Event 

Processing Utility.

2. Click Next. The Site Event Processing Utility wizard appears.

3. Click Next. The license agreement appears.

4. Read the license agreement. If you accept the terms of the license 
agreement, click I accept the terms in the license agreement. 
(If you do not accept the terms, click Cancel to quit the 
installation.)

5. Click Next. The Destination Folder dialog box appears.

6. Do one of the following:
– To change the Destination Folder, click Change, select a new 

Destination Folder, and click Next.
– To accept the default Destination Folder, click Next.

7. The Setup Type dialog box appears. Select Complete.

8. Click Next. The Ready to Install the Program dialog box appears.

9. Click Install. After installation, the Wizard Completed dialog box 
appears. 

10.Click Finish. The Installation Complete dialog box appears.

11.Do one of the following:
– Click Back to install other programs.
– Click Finish.

The Event Processing Utility must be installed on the same PC as 
the Apache HTTP Server.
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Installing the Event Manager
1. In the Site Transaction Set Archiver Setup dialog box, select Event 

Manager.

2. Click Next. The Site Event Manager wizard appears.

3. Click Next. The license agreement appears.

4. Read the license agreement. If you accept the terms of the license 
agreement, click I accept the terms in the license agreement. 
(If you do not accept the terms, click Cancel to quit the 
installation.)

5. Click Next. The Destination Folder dialog box appears.

6. Do one of the following:
– To change the Destination Folder, click Change, select a new 

Destination Folder, and click Next.
– To accept the default Destination Folder, click Next.

7. The Setup Type dialog box appears. Select Complete.

8. Click Next. The Ready to Install the Program dialog box appears.

9. Click Install. After installation, the Wizard Completed dialog box 
appears. 

10.Click Finish. The Installation Complete dialog box appears.

11.Do one of the following:
– Click Back to install other programs.
– Click Finish. 
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The Site Event Manager allows you to select and configure the events for 
which you want to collect data. After testing, event data are collected 
automatically and available in a folder for review.

The Site Event Manager performs the following functions for one or more 
Site Controllers:

– Set Events
– Remove Events
– Copy Events
– Test Events
– Restore Events
– Change Password

Opening Event Manager
Click Start > Programs > Verifone > Site Management Suite > Site Event 
Manager. 

Logging On to Event Manager
In order to use the Site Event Manager, you must log on to a Site 
Controller. Before beginning, obtain the address of the Site (IP address or 
host name), a user name, and a password. 

1. If the Session Log On dialog box is not open, click Log On.

2. Enter the IP address or the host name. 



11 Transaction Set Archiver
3. Enter your user name.

4. Enter your password. (See “Changing the Password > Password 
Guidelines.”)

5. Click OK to connect to the Site Controller.

After you have logged on, the Task Menu appears. At the top of the menu 
is the site name and IP Address of the Site Controller to which you are 
connected.

After 15 minutes of inactivity, the connection is lost and you must 
log on again.
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Setting Events
Each event for which you want to collect data must first be set up on the 
Site Controller.

1. In the Site Event Manager Task Menu, click Set Events.

2. Click Next. The Set Events dialog box appears.

3. Select the Event Type from the drop-down list: Application Start, 
Period Close, Fuel Initialization, or Funds Audit, Manager 
Workstation, Sales Monitor, Peripheral Status. 

You can start over at any time by clicking Clear Form.
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4. The Mapped User is, by default, the logon username. Another 
mapped user can be entered.

5. Enter the Alias. The Alias is a unique name that identifies the 
Mapped User and URL for the selected Event Type.

6. Enter the URL of the computer designated as the “listener” or 
“data collector.” The URL is case sensitive and must be entered as 
follows:
http://nnn.nnn.nnn.nnn/cgi-bin/processSiteEvent

7. Click Set Event.

8. Click Close to return to the Task Menu.

Leave existing one for backward compatibility.
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Removing Events
To prevent data from being collected, events may be removed from the 
Site Controller.

1. In the Site Controller Event Manager Task Menu, click Remove 
Events. 

2. Click Next. The Remove Events dialog box appears.

3. Select the Event Type from the drop-down list. The Alias and URL 
appear in the dialog box.

4. Select the event to delete.

5. Click Remove to delete the event. Click Yes when a message 
appears to ask if you are sure.

6. A message appears stating “Deletion of Event(s) complete.” Click 
OK.

7. Click Close to return to the Task Menu.

Click Refresh to reread the local cached file and update the list 
box with the latest data in the local cache.
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Copying Events
Events may be copied from other sites and added to the site to which you 
are currently connected.

1. In the Site Event Manager Task Menu, click Copy Events.

2. Click Next. The Copy Events dialog box appears.

3. The list box displays the sites for which there is a local cache. 
Select the site from which you want to copy.

4. Click OK. A message appears stating “Copy Completed.” The event 
is copied to the site to which you are currently connected.

5. Click OK.

6. Click Cancel to return to the Task Menu.
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Testing Events
Use the Test Events function to ensure that data are collected and 
available in the correct location.

1. In the Site Event Manager Task Menu, click Test Events.

2. Click Next. The Test Events dialog box appears.

3. Select the Event Type from the drop-down list.

4. Select the URL of the event to be tested.

5. Click OK. A message box appears stating “Repeat Event Request(s) 
Sent.”

6. Click OK. The data that is produced whenever the event occurs are 
now automatically collected and cached in the proper folders.

7. Click Close to return to the Task Menu.

Due to time sensitivity, Funds Audit Event Types cannot be tested.
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Restoring Events
If the Site Controller has been reinstalled, use Restore Events to quickly 
configure the Site for event notification.

1. In the Site Event Manager Task Menu, click Restore Events.

2. Click Next. The Restore Events dialog box appears.

3. Select the Event Type from the drop-down list. The Alias and URL 
appear in the list box.

4. Select the event to restore.

5. Click OK to restore the event. A message appears stating “Events 
Restored.”

6. Click OK.

7. Click Close to return to the Task Menu.

Click Refresh to reread the local cached file and update the list 
box with the latest data in the local cache.
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Changing the Password

Password Guidelines

Follow these guidelines for passwords:
– An Administrator can change your password at any time.
– Passwords must be at least seven (7) characters in length and 

contain at least one (1) digit and one (1) letter.
– Passwords expire at least every 90 days (maybe more 

frequently, depending on configuration.)
– You cannot reuse your last four passwords.

If an invalid password is entered six consecutive times, your user account 
is inactivated for 30 minutes. The Administrator can assign a password so 
that you can log on immediately.

To change your password, follow this procedure:
1. In the Site Event Manager Task Menu, click Change Password. 

2. Click Next. The Change Password dialog box appears. 

3. Enter your current user name and password.

4. In the New Password box, enter the new password.
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5. In the Confirm New Password box, enter the new password.

6. Click OK.

Logging Off Event Manager
To leave a Site Event Manager session, click Log Off. The Session Log On 
dialog box appears so that you can log on again later.

Exiting Event Manager
To close the Site Event Manager, click the “X” in the upper right corner. 



4 EVENT PROCESSING UTILITY

The Site Event Processing Utility allows you to configure a set of 
instructions for any or all of the following event types for which data is 
sent to the Apache server after configuration with Event Manager:

– Application Start
– Period Close (Period 1, 2, 3, or 4)
– Fuel Initialization
– Funds Audit
– Manager Workstation
– Peripheral Status
– Sales Data

The instructions that you configure with the Event Processing Utility 
allow you to save the data to a file, send a message to an email address, 
and/or run a script file to process the data.

The following procedures explain how to create, modify, and remove an 
event process with the Event Processing Utility.

See “Parameter and Values” (at the end of this chapter) for 
information about the parameters and values included in the 
Event Processing Utility. 
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Opening the Event Processing Utility
Click Start > Programs > Verifone > Site Management Suite > Site Event 
Processing Utility. 
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Creating a New Event Process
1. In the main Event Processing Utility window, click New. The Event 

Types appear.

2. Select an Event Type from the following:
– Application Start
– Period Close (Period 1)
– Period Close (Period 2)
– Period Close (Period 3)
– Period Close (Period 4)
– Fuel Initialization
– Funds Audit
– Manager Workstation
– Peripheral Status
– Sales Data Event

3. Click Next. The Source Document Locations appear.
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4. Select the location of the source document from the following:
– Use document contained in event — The event has a document 

that you want to process. Select the option, click Next, and go 
to step 5. 
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– Retrieve a new document from a URL — Get a document to use 
in the process. Select the option, click Next, and do the 
following: 

Retrieve a New Document from a URL

1. In URL Information, select CMD from the Parameter 
Name drop down list and a value from the Parameter 
Value drop down list.

2. Click the arrow to move CMD and the value into the URL 
Parameters box.

3. Repeat steps 1 and 2 for Cookie, with the value 
%~COOKIE%.

4. Add any other parameters in the same manner.

5. Select the type of request that this command is to use.

6. Click Next and go to step 5.
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– Retrieve a new document from a URL using a period list — Get 
a document that requires a period list. Select the option, click 
Next, and do the following: 

Retrieve a New Document from a URL using a Period List

1. In URL Information (see above), select CMD from the 
Parameter Name drop down list and a value from the 
Parameter Value drop down list.

2. Click the arrow to move CMD and the value into the URL 
Parameters box.

3. Repeat steps 1 and 2 for Cookie, with the value 
%~COOKIE%.

4. Add any other parameters in the same manner.

5. Select the type of request that this command is to use.

6. Click Next.

7. In the Period List Information dialog box, repeat 
steps 1 through 4 and click Next.
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Retrieve a New Document from a URL using a Period List
(Continued)

8. In Period List Comparison, enter or browse to the file to 
which you want to compare the Period List to prevent 
duplication of data. 

9. If the path is a URL to the Site, select that option.

10. You may select a variable to add to the file name and 
may also select the option to save the file after 
comparing.

11. Click Next and go to step 5.
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– Use a file — Get a document of your own that you want to use in 
the process. Select the option, click Next, and do the following:

5. The Add Actions dialog box appears.

6. Click New. The Configure Actions dialog box appears.

Use a File

1. In the Source Document Information dialog box, enter 
or browse to the file. 

2. If the path is a URL to the Site, select that option. 

3. You may select a variable to add to the file name.

4. Click Next and go to step 5.
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7. Select from the following actions:
– Save the received data to a file — Select the option and do the 

following:

Save the Received Data to a File

1. In Configure Actions, enter or browse to the path and 
file name. 

2. You may also select a variable to add to the file name.

3. Click Next and go to step 8.
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– Send a message to an email address — Select the option and do 
the following:

Send a Message to an Email Address

1. In Configure Actions, enter the SMTP Server (outgoing 
mail server) that is reachable from the TSA server and 
the Port number. 

Note: Can be on the same server.

2. Enter the Subject and Message. You may select a 
variable to add to the Subject and/or Message.

3. Click Next and go to step 8.
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– Run a script file to process the received data — Select the 
option and do the following:

8. The Apply XML Transform dialog box appears. 

Run a Script File to Process the Received Data

1. In Configure Actions, enter or browse to the path and 
file name of the script. 

2. Enter the Parameter Name and the Parameter Value.

3. Click the arrow to move the Parameter and Value into 
the Script Parameters box.

4. Click Next and go to step 8.
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9. To add a Transform, click New. The Stylesheet dialog box appears.

10.In the Stylesheet dialog box, enter or browse to the file. 

11.If you want to enter a parameter(s) to be applied to the transform 
click New. The Transform Parameter Information dialog box 
appears.
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12.Select the parameter value type from the following:
– Standard Value — Select the option and do the following:

Standard Value

1. Enter the Parameter Name, Parameter Namespace 
(optional), and the Parameter Value.

2. Click Next. (If you want to add another transform, do so 
now.) Click Next to return to the Apply XML Transform 
dialog box. 

3. Click Next and go to step 13.
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– XML — Select the option and do the following:

XML

1. Enter the Parameter Name, Parameter Namespace 
(optional), and the Parameter XML.

2. Click Next. (If you want to add another parameter, do 
so now.) Click Next to return to the Apply XML 
Transform dialog box. 

3. Click Next and go to step 13.
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– Source Document — Select the option and do the following:

Source Document

1. Enter the Parameter Name and Parameter Namespace 
(optional).

2. Click Next. The Enter URL Information dialog box 
appears.
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13.The Error dialog box appears. Select the action to be taken in case 
of an error from the following:
– Nothing (do not do anything if an error occurs) — Select the 

option, click Next, and go to step 14.

Source Document (Continued)

3. Select CMD from the Parameter Name drop down list 
and a value from the Parameter Value drop down list.

4. Click the arrow to move CMD and the value into the URL 
Parameters box.

5. Repeat steps 4 and 5 for Cookie, with the value 
%~COOKIE%.

6. Add any other parameters in the same manner.

7. Select the type of request that this command is to use.

8. Click Next. (If you want to add another parameter, do 
so now.) Click Next to return to the Apply XML 
Transform dialog box. 

9. Click Next and go to step 13.
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– Send a message to an email address — Select the option and do 
the following: 

Send a Message to an Email Address

1. In the Error dialog box, enter SMTP Server (outgoing 
mail server) and the Port number. 

2. Enter the Subject and Message. You may select a 
variable to add to the Subject and/or Message.

3. Click Next and go to step 14.
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– Write the error to a file — Select the option and do the 
following:

14.The Action dialog box appears. Click Next. The Process Name 
dialog box appears.

Write the Error to a File

1. In the Error dialog box, enter or browse to the file to 
which you want to write the error. 

2. You may select a variable to add to the file name.

3. Click Next and go to step 14.
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15.Enter a name for the new event process.

16.Click Finish. The Information Saved box appears.

17.Click OK.

Modifying an Event Process
After you have created an event process, you may modify it by doing the 
following:

1. In the main Event Processing Utility window, select the event 
process that you want to modify and click Modify. The Event Types 
appear.

2. The event type is automatically selected. Click Next.

3. Follow the “Creating a New Event Process” procedure until you 
reach the section(s) of the process that you want to modify.

4. Click Modify and make the change. Continue as in “Creating a New 
Event Process,” making further changes as necessary. 

5. At the end of the procedure, you may keep the same name for the 
modified event process or rename it.

6. Click Finish. The Information Saved box appears.

7. Click OK.

Removing an Event Process
You may remove an event process by doing the following:

1. In the main Event Processing Utility window, select the event 
process you want to remove.

2. Click Remove. The “Are you sure” dialog box appears.

3. Click Yes. The Information Saved box appears.

4. Click OK. The event process is removed.
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Parameters and Values
cmd (parameter) — The cgi command to execute on Site Controller.

cmd Value Description Required 
Parameters

Associated 
pdlist

vrubyrept The Ruby report. reptname
period
filename
cookie

vreportpdlist

vperiodrept (Sapphire 
Only)

Period Report (T-Log). A 
collection of all 
transactions and events 
that occurred in a given 
period.

period
filename
cookie

vtlogpdlist

vperiodreptz 
(Sapphire Only)

Period Report (T-Log). A 
collection of all 
transactions and events 
that occurred in a given 
period (zipped).

period
filename
cookie

vtlogpdlist

vtransSet 
(Commander Only)

Period Report (T-Log). A 
collection of all 
transactions and events 
that occurred in a given 
period.

period
filename
cookie

vtlogpdlist

vtranSetz 
(Commander Only)

Period Report (T-Log). A 
collection of all 
transactions and events 
that occurred in a given 
period (zipped). 

period
filename
cookie

vtlogpdlist

vcashierrept The cashier report for a 
given cashier period, 
register, and cashier.

filename
cashierNum
regNum
cookie

vcashierpdlis
t

vfueltotals Dispenser totals that 
occurred in a given period 
on Site.

period
filename
cookie

vtlogpdlist

vfueltotalsz Dispenser totals that 
occurred in a given period 
on Site (zipped).

period
filename
cookie

vtlogpdlist

vdealcfg (Sapphire 
Only)

The deal (mix-match and 
combo) configuration 
document.

cookie N/A
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vfuelsite (Sapphire 
Only) 

The fuel site configuration 
document, including service 
modes, tanks, blends, 
fueling positions, hose 
assignments, and grade 
pricing.

cookie N/A

vfuelcfg (Commander 
Only)

The fuel site configuration 
document, including service 
modes, tanks, blends, 
fueling positions, hose 
assignments, and grade 
pricing.

cookie N/A

vpopcfg The POP fuel discount 
configuration document. 
Shows   headers, messages, 
and trailers for DCRs.

cookie N/A

vtlssite The tank level sensor 
configuration document.

cookie N/A

vtaxratecfg The tax rate configuration 
document.

cookie N/A

vreportpdlist The list of available periods 
for database-based reports.

cookie N/A

vtlogpdlist The list of available period 
closes for tlog-based 
reports.

cookie N/A

vpayrollpdlist The list of available periods 
for the payroll report 
(previous and current).

cookie N/A

vpayrollpdlist2 The list of available periods 
for the payroll report.

cookie N/A

vnetworkpdlist The list of available periods 
for the network report.

cookie N/A

vcashierpdlist The list of available periods 
for the cashier report.

cookie N/A

vcwpaypointpdlist The list of available periods 
for the car wash pay point 
report.

cookie N/A

vcwpaypointpdrept The actual car wash pay 
point report. 

cookie
filename
period

vcwpaypoint
pdlist

cmd Value Description Required 
Parameters

Associated 
pdlist
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reptname — The name of the Site report.

reptname Value Description
Department Department Report

Summary Summary Report

Tax Tax Report

Loyalty Loyalty Report

Hourly Hourly Report

Network Network Report

netProd Network Product Report

propCard Proprietary Network Card Report

propProd Proprietary Network Product Report

Deal Deal Report

popDisc POP Discount Report

plu PLU Report

pluPromo PLU Promo Report

Category Category Report

dcrStat Fuel DCR Statistics Report

fpHoseTest Fueling Position/Product (Hose) Test Report

fpHose Fueling Position/Product (Hose) Report

fpHoseRunning Fueling Position/Product (Hose) Running Report

prPriceLvl Fuel Product/Price Level Report

slPriceLvl Fuel Service Level/Price Level Report

tierProduct Fuel Tier/Product Report

autoCollect Fuel Autocollect Report

cashAcc Fuel Cash Acceptor Report

tank Fuel Tank Report

tankMonitor Fuel Tank Monitor Report

tankRec Fuel Tank Reconciliation Report

carwash Car Wash Report

moneyOrderDev Money Order Device Report

payroll Payroll Report
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Parameter Value
cookie
The credential that authorizes the 
request to be processed by the Site. 

Value = %~COOKIE%
The value that was in the event received 
from the Site replaces %~COOKIE%.

cashierNum
The cashier number.

Value = %~CSRNUM%
This value may be available in an event 
received from the Site.
Note: See %~CSRNUM% in “Values” below.

filename
The name of the file that contains 
the report data for a given period.

Value = %~FILENAME%
This value may be available in an event 
received from the Site.
Note: See %~FILENAME% in “Values” below.

period
The reporting period 1 - 4.

Value = 1, 2, or %~PERIOD%
This value may be available in an event 
received from the Site.
Note: See %~PERIOD% in “Values” below.

regNum
The register number.

Value = %~REGNUM%
This value may be available in an event 
received from the site.
Note: See %~REGNUM% in “Values” below.

reptnum
The sequence number of the Site 
report. 

Value = 1 - 99, where 1 is current, 2 is most 
recently closed, etc. 
Best practice is to use filename instead of 
reptnum.
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Values

%~CSRNUM%, %~REGNUM%, %~CSRNAME%

%~CSRNUM% —  The number assigned to the cashier (1 - 60) set up through Site 
Management Suite or Configuration Client 

%~REGNUM% — The register number assigned during install

%~CSRNAME% — The cashier name set up through Site Management Suite or 
Configuration Client

Value Extracted From
– The Event.

– The period list. When using “Retrieve a new document from a URL using a period 
list” and the period list is vcashierpdlist, the variable is set to the value of the 
entry in the period list that is being processed.

Availability
This value may be available on any event, but is not guaranteed. The only reliable 
use of this variable is when processing cashier reports from a vcashierpdlist.

Uses
– Parameter name cashierNum and regNum to retrieve cashier reports 

– To create/build unique folders/directories for saveTo, writeTo

– To create/build unique filename for saveTo or writeTo

– To create/build a subject and/or message for emailTo

%~CSRNAME% (cashier name) is not a parameter that would be sent 
to the Site Controller, but is part of the period list.
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%~FILENAME% 

%~FILENAME% — A unique name given by the Point of Sale (POS) to a closed report. The 
name takes the form of a 4-digit year, a 2-digit month, a 2-digit date separated by 
dashes (a date) and a sequence number separated from the date with a period. 
For example: 2008-10-02.011.

Value Extracted From
– The Event 

– The period list. When using “Retrieve a new document from a URL using a period 
list” and using any period list, %~FILENAME% is set to the value of the filename of 
an entry in the period list that is being processed.

Availability
This value may be available on any event, but is not guaranteed. The only reliable 
use of this variable is when processing reports from a period list such as 
vtlogpdlist, vreportpdlist, or vcashierpdlist.

Uses:
– Parameter name of filename to retrieve reports

– To create/build unique folders/directories for saveTo, writeTo 

– To create/build unique filename for saveTo or writeTo

– To create/build a subject and/or message for emailTo

%~PERIOD% 

%~PERIOD% — A numeric value (1 - 4) representing a reporting period.

Value Extracted From
– The Event 

– The periodCloseEvent entry (added through the Event Processing Utility).

Availability
This value may be available on any event, but is not guaranteed. The only reliable 
use of this variable is when processing periodCloseEvents.

Uses
– Parameter name of period to retrieve reports

– To create/build unique folders/directories for saveTo, writeTo

– To create/build unique filename for saveTo or writeTo

– To create/build a subject and/or message for emailTo
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%~SITE%

%~SITE% — The site/store number assigned during install through Site Management Suite 
or Configuration Client.

Value Extracted From 
The Event

Availability
This value is always available.

Uses
– To create/build folders/directories for site-specific storage for saveTo or writeTo

– To create/build site-specific filenames for saveTo or writeTo

– To create/build a subject or message for email and specifically identify the site 
from which the event came

%~CURxxx%

%~CURYEAR2% — The last 2 digits of the current year.

%~CURYEAR4% — The full 4 digits of the current year.

%~CURMONTH% — The 2-digit month for the current month.

%~CURDATE% — The 2-digit day of the current month.

%~CURDAY% — The name of the day of the week equal to the 2-digit day of the current 
month. 

%~CURHOUR% — The 2-digit hour in 24 hours for the current hour. 

%~CURMINUTE% — The 2-digit minutes for the current minutes.

%~CURSECOND% — The 2-digit seconds for the current seconds.

Value Extracted From
The system that is hosting Transaction Set Archiver

Availability
The value is always available.

Uses
– To create/build folders/directories for saveTo or writeTo

– To create/build filenames for saveTo or writeTo

– To create/build a subject and/or message for emailTo
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%~BUSxxx

%~BUSYEAR2% — The last 2 digits of the open time of a reporting period

%~BUSYEAR4% — The full 4 digits of the open time of a reporting period

%~BUSMONTH% — The 2-digit month of the open time of a reporting period

%~BUSDATE% — The 2-digit day of the open time of a reporting period 

%~BUSDAY% — The name of the day of the week equal to the 2-digit day of the open 
time of a reporting period 

%~BUSHOUR% — The 2-digit hour in 24 hours of the open time of a reporting period

%~BUSMINUTE% — The 2-digit minutes of the open time of a reporting period

%~BUSSECOND% — The 2-digit seconds of the open time of a reporting period 

Value Extracted From
– A source document retrieved using vperiodrept

– A source document retrieved using vrubyrept

– A source document retrieved using vfueltotals

– A source document retrieved using vcashierrept

– A source document retrieved using vpayrollrept

– A source document retrieved using vcwpaypointpdrept

– A source document retrieved using vtransset

Note: The option to deliver the data in gzip format is available for vperiodrept and 
vfueltotals.

Availability
The value is available only if the source document is one of the above. Business 
date is extracted from the source document after it has been retrieved and 
represents the date and time the report was opened.

Uses
– To create/build folders/directories for saveTo or writeTo

– To create/build filenames for saveTo or writeTo

– To create/build a subject or message for emailTo
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%~SEQNUM

%~SEQNUM% — A unique 3-digit sequence number assigned by the Point of Sale (POS). 

Value Extracted From
– A source document retrieved using vperiodrept

– A source document retrieved using vrubyrept

– A source document retrieved using vfueltotals

– A source document retrieved using vcashierrept

– A source document retrieved using vpayrollrept

– A source document retrieved using vcwpaypointpdrept

– A source document retrieved using vtransset

Note: The option to deliver the data in gzip format is available for vperiodrept and 
vfueltotals.

Availability
The value is available only if the source document is one of the above. Sequence 
number is extracted from the source document after it has been retrieved.

Uses
– To create/build folders/directories for saveTo or writeTo

– To create/build filenames for saveTo or writeTo

– To create/build a subject and/or message for emailTo
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Viewing Data

Windows Explorer

Use Windows Explorer to view data directly.
1. In Windows Explorer, navigate to C:\siteController\tlogs folder and 

navigate to the appropriate sitename and period folder.

2. Double-click the folder named for the site.

3. Do one of the following:
– Double-click the .xml file to review the data.
– Double-click the zip file to open it, then double-click the .xml 

file to review the data.

Transaction Manager

Use the Site Management Suite Transaction Manager to view and filter 
data.

1. Log on to the Site Management Suite Transaction Manager.

2. Click Tools > Transaction Viewer or Tools > Transaction Manager 
to open the tool you want to use.

3. Click File > Open Local TLog and browse to C:\siteController.

4. Open the “sitename” folder and select the TLog data you want to 
view.

5. Click Open. The data appear in the Transaction Viewer or the 
Transaction Manager.

Click Help > Documentation for information about the Transaction 
viewer and Transaction Manager.
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Setting Up for Data Refresh
The Transaction Set Archiver recognizes previously collected data and 
does not collect duplicate data. However, you might want to collect all 
data again for a particular event or period. Use the procedure below for 
both Event and Poll Mode data collection. 

1. In Windows Explorer, navigate to C:\Program 
Files\Verifone\TSAScripts\siteInfo\processTransactionSets.

2. Locate and move or delete the site name file (for example, AB123-
2.xml).

The next time the event or period data are collected, all data will be 
collected again.

Forcing Events

To collect event data immediately, use the “Testing Event Setup” 
procedure to force the Site Controller to repeat the last closed event.

You must select the correct event.
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Viewing Logs
Note: All Transaction Set Archiver logs roll over and therefore do not 

require maintenance to prevent large files.

Event Logs

1. In Windows Explorer, navigate to 
C:\ProgramFiles\Verifone\tsaScripts\Logs.

2. Double-click process.logN to view the event mode log. The log file 
displays the inbound event and the IP address and confirms that 
Transaction Set Archiver received the event.

If an expected event is not listed in the log, the likely cause is one 
of the following: 
– The Site did not send the event data. 
– The Apache HTTP Server is not operating properly.
– The network was disconnected at the time the event was sent.

3. All further logging for the event is stored in the folder named for 
the site in C:\Program Files\Verifone\TSAScripts\Logs. Open the 
site folder and double-click process.logN to view the event log.

Apache HTTP Server Logs

By default, Apache logging is turned off. See the Apache documentation 
for information about enabling and maintaining Apache log files.

1. In Windows Explorer, navigate to C:\Program Files\Apache 
Group\Apache\logs.

2. Double-click on access.log (details of incoming server traffic), or 
error.log (issues associated with granting requests). 
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Enable White List Processing
This new feature enables the TSA server to connect to the Site to retrieve 
data after receiving the event notification through a proxy server. 

1. In Windows Explorer, navigate to C:\Program Files(x86)\VeriFone\ 
TSAScripts\siteEvent\whiteListSample (default install). 

2. Double-click on whiteListSample.xml.

The following is the content of whiteListSample.xml:
<?xml version="1.0" encoding="UTF-8"?>
<tsa:whiteList xmlns:tsa="urn:vfi-sapphire:tsa.2009-04-21" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<!--
To enable White List Processing: 

1) Copy this file to the siteEvent directory where 
processEvent.wsf is. 
2) Rename the file to whiteList.xml
3) Add entry elements specifying the siteNumber 
(store number) and the IP address of the site.

<entry siteNumber="1" ipAddress="10.10.10.1"/>
-->
</tsa:whiteList>

3. Use the steps within the file to enable White List Processing. 

The only entries needed are those sites that have a proxy server in 
the path (route) from the site to the TSA server.
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